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Вступ 
Метою цих вправ є освоєння технології проектування інформаційних систем з позиції 

об'єктно-орієнтованого проектування (ООП) на основі мови UML.  
Вправи містять 10 лабораторних робіт, кожну з яких студент може виконувати самостійно, 

консультуючись із викладачем. 
Передбачається, що студент паралельно до виконання вправ самостійно та в рамках 

лекційного курсу ознайомиться з основними ідеями мови UML та роботи в IBM Rational. 
На прикладі модельного завдання з автоматизації бізнес-процесів роботи торговельного 

підприємства показані всі етапи проектування автоматизованої системи мовою UML, 
включаючи код генерації. 

Для виконання лабораторних робіт на комп'ютері має бути встановлений пакет IBM 
Rational 

На одну вправу приділяється 0.5 год. Як звіт надається файл збереженого проекту та його 
(якщо можливо) візуалізація. 
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Робота (вправа) 1. Створення діаграми варіантів використання 
Постановка задачі 

"Знову!" - сказав Боб, повісивши слухавку. 
Мері глянула на нього, відірвавшись від комп'ютера: "У чому річ?" 
"Четвертий раз за цей місяць один із наших клієнтів скаржиться, що не отримав свого 

замовлення. Якщо так продовжуватиметься і далі, ми вилетимо зі справи." 
"Ми просто занадто швидко ростемо. Обробка всіх замовлень на папері проходила чудово, 

коли наша компанія складалася з п'яти осіб. Не можна чекати від неї такої роботи тепер. Давай 
поговоримо зі Сьюзан, можливо, ми зуміємо". спроектувати систему, яка допоможе нам 
упоратися з усім цим." 

Robertson's Cabinets, Inc. - це маленька компанія, що спеціалізується на виробництві 
стандартних та нестандартних кухонних шаф. Компанія почалася з невеликої групи 
підприємців, що зібралися разом. Коли справа почалася три роки тому, надходило надто мало 
замовлень, і вони цілком могли впоратися з ними на папері. Зі зростанням їхньої репутації 
кількість замовлень зростала. Довелося найняти нових робітників, і за три роки фірма виросла 
до магазину з більш як 50 співробітниками. 

Хоча це ще невелика компанія, але вона виросла вже настільки, що вже не могла більше 
покладатися на обробку замовлень вручну. Власники фірми Боб і Мері Робертсон вирішили 
поговорити зі Сьюзан, щоб вирішити цю проблему. Сьюзан - це одна з небагатьох фахівців з 
комп'ютерів, що входять у відділення цієї фірми, що займається інформаційними технологіями. 

Боб пішов дзвонити Сьюзан. 
"Цілком очевидно, що нам потрібна система обробки замовлень. Ми зіткнулися з 

серйозним ризиком втратити клієнтів." 
"Згідна." 
"Можеш ти розробити програму на Java, яка відстежувала б замовлення?" 
"Поки що не хвилюйтеся з приводу реалізації. Давайте вирішимо, чого ви хочете від 

системи?" 
"Потрібно, щоб вона відстежувала замовлення." 
"Не міг би ти бути конкретнішим? Давай розглянемо нинішній процес". 
"Добре, отримавши дзвінок, ми заповнюємо форму замовлення. Ми передаємо її Клінту в 

магазин, він заповнює всі необхідні документи і готує відправку товару клієнту. Копію форми ми 
віддаємо Дону в бухгалтерію. Він вводить її в бухгалтерську систему та виписує рахунок". 

"І ви хочете, щоб нова система підтримувала весь цей процес?" 
"Точно". 
З цієї розмови Сьюзан змогла зрозуміти, що система має забезпечувати можливість 

додавання нових замовлень, зміни старих, виконання замовлень, перевірки та поновлення 
інвентарних описів. При отриманні замовлення система повинна також надіслати повідомлення 
бухгалтерській системі, яка виписує рахунок. Якщо необхідного товару немає на складі, 
замовлення має бути відхилено. Потім Сьюзан перетворила вимоги на діаграму Варіантів 
Використання, за допомогою якої почала моделювати систему. 

Створення діаграми Варіантів Використання 
Створіть діаграму Варіантів Використання системи обробки замовлень. Необхідні при 

цьому дії докладно перелічені далі. Готова діаграма Варіантів Використання має виглядати на 
малюнку 1. 
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Етапи виконання Робота (вправа) 
Створити діаграми Варіантів Використання, варіантів використання та Діючих осіб 

1. Двічі клацніть на Головній діаграмі Варіантів Використання (Main) у броузері, щоб 
відкрити її. 

2. За допомогою кнопки Use Case (Варіант Використання) на панелі інструментів 
помістіть на діаграму новий варіант використання. 

3. Назвіть новий варіант використання "Ввести нове замовлення". 
4. Повторіть етапи 2 і 3, щоб помістити на діаграму інші варіанти використання: Змінити 

існуюче замовлення, Надрукувати інвентарний опис, Оновити інвентарний опис, 
Оформити замовлення, Відхилити замовлення 

5. За допомогою кнопки Actor (Діюча особа) панелі інструментів помістіть на діаграму 
нову дійову особу. 

6. Назвіть його "Продавець" 
7. Повторіть кроки 5 і 6, помістивши на діаграму інших дійових осіб: Керуючий 

магазином, Клерк магазину, Бухгалтерська система 

 
Мал. 1. Діаграма Варіантів Використання системи обробки замовлень. 

Вказати абстрактні варіанти використання 
1. Клацніть правою кнопкою миші на варіанті використання "Відхилити замовлення" на 

діаграмі. 
2. У меню виберіть Open Specification (Відкрити специфікацію). 
3. Позначте контрольний перемикач Abstract (Абстрактний), щоб зробити цей варіант 

використання абстрактним. 
Додати асоціації 

1. За допомогою кнопки Unidirectional Association (Односпрямована асоціація) панелі 
інструментів намалюйте асоціацію між дійовою особою Продавець та варіантом 
використання "Ввести нове замовлення". 

Оформить заказ

Изменить сущест-
вующий заказ

Бухгалтерская система

Продавец

Ввести
новый заказ

Отклонить заказ

Клерк в
магазине

Обновить инвен-
тарную опись

Управляющий
магазином

Напечатать ин-
вентарную опись

<<extends>>
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2. Повторіть цей етап, щоб помістити на діаграму решту асоціацій. 
Додати зв'язок розширення 

1. За допомогою кнопки Generalization панелі інструментів намалюйте зв'язок між 
варіантом використання "Відхилити замовлення" та варіантом використання 
"Оформити замовлення". Стрілка має простягтися від першого варіанта 
використання до другого. Зв'язок розширення означає, що варіант використання 
"Відхилити замовлення" за необхідності доповнює функціональні можливості 
варіанта використання "Оформити замовлення". 

2. Клацніть правою кнопкою миші на новому зв'язку між варіантами використання 
"Відхилити замовлення" та "Оформити замовлення". 

3. У меню виберіть Open Specification (Відкрити специфікацію). 
4. У списку стереотипів, що розкривається, введіть слово extends (розширення), потім 

натисніть ОК. 
5. Слово «extends» з'явиться на лінії цього зв'язку. 

Додати опис до варіантів використання 
1. Виділіть у броузері варіант використання "Ввести нове замовлення". 
2. У вікні документації введіть наступний опис цього варіанта використання: Цей 

варіант використання дає клієнту можливість ввести нове замовлення до системи. 
3. За допомогою вікна документації введіть описи до всіх інших варіантів використання. 

Додати опис до дійової особи 
1. Виділіть у броузері дійову особу Продавець 
2. У вікні документації введіть для цієї дійової особи наступний опис: Продавець - це 

службовець, який доставляє та намагається продати продукцію. 
3. За допомогою вікна документації введіть опис до дійових осіб, що залишилися. 

Прикріплення файлу до варіанта використання 
1. Для опису головного потоку подій варіанта використання "Ввести нове замовлення" 

створіть файл OrderFlow.doc, що містить наступний текст: 
1. Продавець вибирає пункт "Створити нове замовлення" з меню. 
2. Система виводить форму "Подробиці замовлення". 
3. Продавець вводить номер замовлення, замовника та те, що замовлено. 
4. Продавець зберігає замовлення. 
5. Система створює нове замовлення та зберігає його в базі даних. 

2. Клацніть правою кнопкою миші на варіанті використання "Ввести нове замовлення". 
3. У меню виберіть Open Specification (Відкрити специфікацію) 
4. Перейдіть на вкладку файлів. 
5. Клацніть правою кнопкою миші на білому полі та з меню виберіть Insert File (Ввести 

файл). 
6. Вкажіть файл OpenFlow.doc і натисніть кнопку Open (Відкрити), щоб прикріпити файл 

до варіанта використання. 
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Робота (вправа) 2. Створення діаграм взаємодії 
У цій вправі будуть розроблені діаграми Послідовності та Кооперативні діаграми, що 

описують введення нового замовлення до нашої системи обробки замовлень. 
 

Постановка задачі 
Поговоривши з Бобом, Сьюзан зрозуміла, що повинна робити система обробки замовлень, 

яку вона розробляє для фірми Robertson's Cabinets. Вона намалювала діаграму варіантів 
використання. Вивчивши цю діаграму, всі дійшли згоди щодо галузі застосування системи. 

Тепер настав час аналізу її складових частин. Вищий пріоритет серед користувачів має 
варіант використання "Ввести нове замовлення", він пов'язаний з найбільшим ризиком. У 
зв'язку з цим Сьюзан вирішила зайнятися ним насамперед. 

Вона поговорила з Карлом, завідувачем відділу продажу. Вони удвох обговорили потік 
подій, який буде реалізовуватись у варіанті використання. 

Отримавши потрібну їй інформацію, Сьюзан засіла за опис сценаріїв. В результаті її опис 
виглядав таким чином: 

1. Продавець запроваджує нове замовлення. 
2. Продавець намагається запровадити замовлення, але товару немає на складі. 
3. Продавець намагається ввести замовлення, але при його збереженні у базі даних 

сталася помилка. 
Потім вона приступила до створення діаграм послідовності та кооперативних діаграм для 

сценарію "Ввести нове замовлення". 
 

Створення діаграм Взаємодія 
Створіть діаграму Послідовності та Кооперативну діаграму, яка відображатиме введення 

нового замовлення в систему обробки замовлень. Готова діаграма Послідовності має 
виглядати на малюнку 5. 

Це лише одна з діаграм, необхідних для моделювання варіанта використання "Ввести нове 
замовлення". Вона відповідає успішному варіанту перебігу подій. Для опису того, що трапиться, 
якщо виникне помилка, або якщо користувач вибере інші дії із запропонованих, доведеться 
розробити інші діаграми. Кожен альтернативний потік варіанта використання може бути 
промодельований за допомогою власних діаграм Взаємодії. 

Етапи виконання Робота (вправа) 
Налаштування 

1. У меню моделі виберіть Tools > Options (Інструменти > Установки). 
2. Перейдіть на вкладку діаграм. 
3. Контрольні перемикачі Sequence Numbering, Collaboration Numbering та Focus of 

Control повинні бути позначені. 
4. Натисніть кнопку ОК, щоб вийти з вікна параметрів. 

Створення діаграми Послідовності 
1. Клацніть правою кнопкою миші на Логічному поданні броузера. 
2. У меню виберіть New > Sequence Diagram. 
3. Назвіть нову діаграму "Введення замовлення". 
4. Двічі клацніть на ній, щоб відкрити її. 

Додавання на діаграму дійової особи та об'єктів 
1. Перетягніть дійову особу Продавець (Salesperson) з броузера на діаграму. 
2. Натисніть кнопку Object (Об'єкт) на панелі інструментів. 
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3. Клацніть у верхній частині діаграми, щоб помістити туди новий об'єкт. 
4. Назвіть об'єкт "Order Options Form - Вибір варіанта замовлення". 
5. Повторіть етапи 3 і 4, щоб помістити на діаграму всі інші об'єкти: 

# "Order Detail Form" - Форма Деталі замовлення 
# "Order N1234" - Замовлення №1234. 

Додавання повідомлень на діаграму 
1. Натисніть кнопку Object Message (Повідомлення об'єкта) на панелі інструментів. 
2. Проведіть мишею від лінії життя актора Продавець до лінії життя об'єкта Виберіть 

варіант замовлення. 
3. Виділивши повідомлення, введіть його ім'я Create New Order -- Створити нове 

замовлення. 
4. Повторіть етапи 2 та 3, щоб помістити на діаграму додаткові повідомлення: 

# Open form -- Відкрити форму (між Вибором варіанта замовлення та Деталями замовлення) 
# Enter order number, customer, order items -- Ввести номер замовлення, замовника та кількість 
предметів, що замовляються (між Продавцем і Деталями замовлення) 
# Save the order - Зберегти замовлення (між Продавцем та Деталями замовлення) 
# Create new, blank order -- Створити порожнє замовлення (між Деталями замовлення та 
Замовленням №1234) 
# Set the order number, customer, order items -- Ввести номер замовлення, замовника і кількість 
предметів, що замовляються (між Деталями замовлення та Замовленням №1234). 
# Save the order - Зберегти замовлення (між Деталями замовлення та Замовленням №1234) 

Ми завершили перший етап роботи. Готова діаграма Послідовності представлено малюнку 
2. 

 
Мал. 2. Діаграма Послідовності введення нового замовлення після завершення першого 

етапу роботи. 
Тепер треба подбати про керуючі об'єкти та взаємодію з базою даних. Як видно з діаграми, 

об'єкт Деталі замовлення має безліч відповідальностей, з якими найкраще міг би впоратися 

Форма выбора
варианта заказа

Форма Детали
заказа Заказ №1234

1: Создать
новый заказ

3: Ввести номер заказа, заказчика и заказываемые предметы

Продавец

2: Открыть форму

5: Создать пустой заказ

4: Сохранить заказ

6: Задать номер заказа, заказчика и заказываемые предметы

7: Сохранить заказ
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об'єкт, що управляє. Крім того, нове замовлення має зберігати себе в базі даних сам. 
Ймовірно, цей обов'язок краще було б перекласти на інший об'єкт. 
Додавання на діаграму додаткових об'єктів 

1. На панелі інструментів натисніть кнопку Object. 
2. Клацніть між об'єктами Деталі замовлення та Замовлення №1234, щоб помістити 

туди новий об'єкт. 
3. Введіть ім'я об'єкта - Order Manager (Керуючий замовленнями). 
4. На панелі інструментів натисніть кнопку Object. 
5. Новий об'єкт розташуйте праворуч від Замовлення №1234. 
6. Введіть його ім'я - Transaction Manager (Керуючий транзакціями). 

Призначення відповідальності об'єктам 
1. Перейдіть до повідомлення 5 (Створити порожнє замовлення). 
2. Натисніть комбінацію клавіш CTRL+D, щоб видалити це повідомлення. 
3. Повторіть етапи 1 і 2, щоб видалити два останні повідомлення: 

# Вести номер замовлення, замовника та кількість предметів, що замовляються 
# Зберегти замовлення 

4. На панелі інструментів натисніть кнопку Object Message. 
5. Помістіть на діаграму нове повідомлення, розташувавши його під повідомленням 4 

між Деталями замовлення та Керуючим замовленнями. 
6. Назвіть його Save the order (Зберегти замовлення). 
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Мал. 3. Діаграма Послідовності із новими об'єктами. 

7. Повторіть етапи 4 - 6, додавши повідомлення з шостого до дев'ятого і назвавши їх: 
# Create new, blank order (Створити нове замовлення) – між Управляючим замовленнями та 

Замовленням №1234. 
# Set the order number, customer, order items (Вісті номер замовлення, замовника та кількість 

предметів, що замовляються) - між Управляючим замовленнями та Замовленням №1234. 
# Save the order (Зберегти замовлення) - між Керуючим замовленнями та Керуючим транзакціями. 
# Collect order information (Інформація про замовлення) - між Управляючим транзакціями та 

Замовленням №1234. 
8. На панелі інструментів натисніть Message to Self (Повідомити себе). 
9. Клацніть на лінії життя об'єкта Керуючий транзакціями нижче повідомлення 9, 

додавши рефлексивне повідомлення. Назвіть його Save the order information to the 
database (Зберегти інформацію про замовлення бази даних). 

Тепер діаграма Послідовності має виглядати на малюнку 3. 
Співвіднесення об'єктів із класами 

1. Клацніть правою кнопкою миші на об'єкті Вибір варіанта замовлення. 
2. У меню виберіть Open Specification (Відкрити специфікацію). 
3. У списку класів виберіть <New> (Створити). З'явиться вікно специфікації класів. 
4. Введіть ім'я OrderOptions (Вибір замовлення) у полі імені. 
5. Натисніть кнопку ОК. Ви повернетеся до вікна специфікації об'єкта. 
6. У списку класів виберіть клас OrderOptions. 

Форма выбора
варианта заказа

Форма Детали
заказа Заказ №1234

1: Создать
новый заказ

3: Ввести номер заказа, заказчика и заказываемые предметы

Продавец

Менеджер
заказов

2: Открыть форму

6: Создать пустой заказ

Менеджер
транзакций

4: Сохранить заказ

7: Задать номер заказа, заказчика и заказываемые предметы

8: Сохранить заказ

5: Сохранить заказ

9: Собрать информацию о заказе

10:Сохранить информацию о заказе в базе данных
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7. Натисніть кнопку ОК, щоб повернутися до діаграми. Тепер об'єкт називається Order 
Options Form: OrderOptions (Вибір варіанта замовлення: OrderOptions). 

8. Для співвіднесення інших об'єктів із класами повторіть етапи з 1 по 7: 
# Клас OrderDetail співвіднесіть з об'єктом Деталі замовлення. 
# Клас OrderMgr - з об'єктом Керуючий замовленнями. 
# Клас Order - з об'єктом Замовлення №1234. 
# Клас TransactionMgr - з об'єктом Керуючий транзакціями. 

Після завершення цих дій ваша діаграма має виглядати як на рис. 4. 
 

 
Мал. 4. Діаграма Послідовності із іменами класів. 

Співвідношення повідомлень з операціями 
1. Клацніть правою кнопкою на повідомленні 1, Створити нове замовлення. 
2. У меню виберіть <new operation> (створити операцію). Відобразиться вікно 

специфікації операції. 
3. У полі імені введіть ім'я операції - Create (Створити). 
4. Натисніть кнопку ОК, щоб закрити вікно специфікації операції та повернутися на 

діаграму. 
5. Ще раз клацніть правою кнопкою миші на повідомленні 1. 
6. У меню виберіть нову операцію Create(). 
7. Повторіть повідомлення з 1 по 6, доки не співвіднесете з операціями всі інші 

повідомлення: 
# Повідомлення 2: Відкрити співвіднесіть з операцією Open () 

Форма выбора
варианта заказа:

ВыборЗаказа

Форма Детали
заказа:

ДеталиЗаказа
Заказ №1234:

Заказ

1: Создать
новый заказ

3: Ввести номер заказа, заказчика и заказываемые предметы

Продавец

Менеджер
заказов:

МенеджерЗаказов

2: Открыть форму

6: Создать пустой заказ

Менеджер
транзакций:
Менеджер
транзакций

4: Сохранить заказ

7: Задать номер заказа, заказчика и заказываемые предметы

8: Сохранить заказ

5: Сохранить заказ

9: Собрать информацию о заказе

10:Сохранить информацию о заказе в базе данных
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# Повідомлення 3: Ввести номер замовлення, замовника і кількість предметів, що замовляються - 
з операцією SubmitInfo(). 
# Повідомлення 4: Зберегти замовлення – з операцією Save (). 
# Повідомлення 5: Зберегти замовлення - з операцією SaveOrder (). 
# Повідомлення 6: Створити порожнє замовлення - з операцією Create (). 
# Повідомлення 7: Ввести номер замовлення, замовника і кількість предметів, що замовляються - 
з операцією SetInfo(). 
# Повідомлення 8: Зберегти замовлення - з операцією SaveOrder (). 
# Повідомлення 9: Інформація про замовлення - з операцією GetInfo (). 
# Повідомлення 10: Зберегти інформацію про замовлення в базі даних – з операцією Commit. 

Ваша діаграма має виглядати як на малюнку 5. 
 

 
Мал. 5. Діаграма Послідовності із показаними на ній операціями. 

Створення Кооперативної діаграми 
Для створення Кооперативної діаграми досить просто натиснути клавішу F5 або, якщо ви 

бажаєте самі виконати всі необхідні операції, скористайтеся наведеним далі планом. 
1. Клацніть правою кнопкою миші на Логічному поданні у броузері. 
2. У меню виберіть New > Collaboration Diagram. 
3. Назвіть цю діаграму Введення замовлення. 
4. Клацніть двічі, щоб відкрити її. 

 
Додавання дійової особи та об'єктів на діаграму 

1. Перетягніть дійову особу Продавець (Salesperson) з броузера на діаграму. 
2. Натисніть кнопку Object (Об'єкт) на панелі інструментів. 

Форма выбора
варианта заказа:

ВыборЗаказа

Форма Детали
заказа:

ДеталиЗаказа
Заказ №1234:

Заказ

1: Create()

3: SubmitInfo()

Продавец

Менеджер
заказов:

МенеджерЗаказов

2: Open()

6: Create()

Менеджер
транзакций:
Менеджер
транзакций

4: Save()

7: SetInfo()

8: SaveOrder()

5: SaveOrder()

9: GetInfo()

10: Commit()
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3. Клацніть десь всередині діаграми, щоб помістити туди новий об'єкт. 
4. Назвіть об'єкт "Order Options Form" -- Виберіть варіант замовлення. 
5. Повторіть етапи 3 і 4, щоб помістити на діаграму всі інші об'єкти: 

# "Order Detail Form" - Форма Деталі замовлення 
# "Order N1234" - Замовлення №1234. 

Додавання повідомлень на діаграму 
1. На панелі інструментів натисніть кнопку Object Link (Зв'язок об'єкта). 
2. Проведіть мишею від дійової особи Продавець до об'єкта Вибір варіанта замовлення. 
3. Повторіть етапи 1 і 2, з'єднавши зв'язками такі об'єкти: 
# Чинна особа Продавець та об'єкт Деталі Замовлення. 
# Об'єкт Вибір варіанта замовлення та об'єкт Деталі замовлення. 
# Об'єкт Деталі замовлення та об'єкт Замовлення №1234. 

4. На панелі інструментів натисніть кнопку Link Message. 
5. Клацніть на зв'язку між Продавцем та Вибором варіанта замовлення. 
6. Виділивши повідомлення, введіть його ім'я Create New Order - Створити нове 

замовлення. 
7. Повторіть етапи з 4 по 6, помістивши на діаграму всі інші повідомлення, як показано 

нижче: 
# Open form -- Відкрити форму (між Вибором варіанта замовлення та Деталями замовлення) 
# Enter order number, customer, order items -- Ввести номер замовлення, замовника та кількість 

предметів, що замовляються (між Продавцем і Деталями замовлення) 
# Save the order - Зберегти замовлення (між Продавцем та Деталями замовлення) 
# Create new, blank order -- Створити порожнє замовлення (між Деталями замовлення та 

Замовленням №1234) 
# Set the order number, customer, order items -- Ввести номер замовлення, замовника і кількість 

предметів, що замовляються (між Деталями замовлення та Замовленням №1234). 
# Save the order - Зберегти замовлення (між Деталями замовлення та Замовленням №1234) 
 
Тепер, як і раніше, треба продовжити роботу та помістити на діаграму додаткові елементи, 

а також розглянути відповідальність об'єктів. 
Додавання на діаграму додаткових об'єктів 

1. На панелі інструментів натисніть кнопку Object. 
2. Клацніть десь на діаграмі, щоб помістити туди новий об'єкт. 
3. Введіть ім'я об'єкта - Order Manager (Керуючий замовленнями). 
4. На панелі інструментів натисніть кнопку Object. 
5. Помістіть ще один об'єкт на діаграму. 
6. Введіть його ім'я - Transaction Manager (Керуючий транзакціями). 

Призначення відповідальності об'єктам 
1. Перейдіть до повідомлення 5 (Створити порожнє замовлення). Виділяйте слова, а чи 

не стрілку. 
2. Натисніть комбінацію клавіш CTRL+D, щоб видалити це повідомлення. 
3. Повторіть етапи 1 та 2, щоб видалити повідомлення 6 та 7: 

# Вести номер замовлення, замовника та кількість предметів, що замовляються 
# Зберегти замовлення 

4. Виділіть зв'язок між об'єктами Деталі замовлення та Замовлення №1234. 
5. Натисніть комбінацію клавіш CTRL+D, щоб видалити цей зв'язок. 
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6. На панелі інструментів натисніть кнопку Object Link (Зв'язок об'єкта). 
7. Намалюйте зв'язок між Деталь Замовлення та Керуючим замовленнями. 
8. На панелі інструментів натисніть кнопку Object Link (Зв'язок об'єкта). 
9. Намалюйте зв'язок між Управляючим замовленнями та Замовленням №1234. 
10. На панелі інструментів натисніть кнопку Object Link (Зв'язок об'єкта). 
11. Намалюйте зв'язок між Замовленням №1234 та Управителем транзакцій. 
12. На панелі інструментів натисніть кнопку Object Link (Зв'язок об'єкта). 
13. Намалюйте зв'язок між Керуючим замовленнями та Керуючим транзакцій. 
14. На панелі інструментів натисніть кнопку Link Message. 
15. Клацніть на зв'язку між об'єктами Деталі замовлення та Керуючим замовленнями, 

щоб ввести нове повідомлення. 
16. Назвіть це повідомлення Save the order (Зберегти замовлення). 
17. Повторіть етапи 14 - 16, додавши повідомлення з шостого до дев'ятого і назвавши їх: 

# Create new, blank order (Створити нове замовлення) – між Управляючим замовленнями та 
Замовленням №1234. 

# Set the order number, customer, order items (Вісті номер замовлення, замовника та кількість 
предметів, що замовляються) - між Управляючим замовленнями та Замовленням №1234. 

# Save the order (Зберегти замовлення) - між Керуючим замовленнями та Керуючим транзакціями. 
# Collect order information (Інформація про замовлення) - між Управляючим транзакціями та 

Замовленням №1234. 
18. На панелі інструментів натисніть Message to Self (Повідомити себе). 
19. Клацніть на об'єкті Керуючий транзакціями, додавши до нього рефлексивне 

повідомлення. 
20. На панелі інструментів натисніть кнопку Link Message. 
21. Клацніть на рефлексивному зв'язку Керуючого транзакціями, щоб ввести туди 

повідомлення. 
22. Назвіть нове повідомлення Зберегти інформацію про замовлення в базі даних. 

Співвіднесення об'єктів із класами (якщо розробки описаної вище діаграми 
Послідовності самі класи ви створили) 

1. Знайдіть у броузері клас OrderOptions. 
2. Перетягніть його на об'єкт Вибір варіанта замовлення на діаграмі. 
3. Повторіть етапи 1 і 2, співвідносячи інші об'єкти та відповідні їм класи: 

# Клас OrderDetail співвіднесіть з об'єктом Деталі замовлення. 
# Клас OrderMgr - з об'єктом Керуючий замовленнями. 
# Клас Order - з об'єктом Замовлення №1234. 
# Клас TransactionMgr - з об'єктом Керуючий транзакціями. 

Співвіднесення об'єктів із класами (якщо ви не створювали описану вище діаграму 
Послідовності) 

1. Клацніть правою кнопкою миші на об'єкті Вибір варіанта замовлення. 
2. У меню виберіть Open Specification (Відкрити специфікацію). 
3. У списку класів виберіть <New> (Створити). З'явиться вікно специфікації класів. 
4. Введіть ім'я OrderOptions (Вибір замовлення) у полі імені. 
5. Натисніть кнопку ОК. Ви повернетеся до вікна специфікації об'єкта. 
6. У списку класів виберіть клас OrderOptions. 
7. Натисніть кнопку ОК, щоб повернутися до діаграми. Тепер об'єкт називається Order 

Options Form: OrderOptions (Вибір варіанта замовлення: OrderOptions). 
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8. Для співвіднесення інших об'єктів із класами повторіть етапи з 1 по 7: 
# Клас OrderDetail співвіднесіть з об'єктом Деталі замовлення. 
# Клас OrderMgr - з об'єктом Керуючий замовленнями. 
# Клас Order - з об'єктом Замовлення №1234. 
# Клас TransactionMgr - з об'єктом Керуючий транзакціями. 

Співвідношення повідомлень із операціями (якщо при розробці описаної вище діаграми 
Послідовності самі операції ви вже створили) 

1. Клацніть правою кнопкою на повідомленні 1, Створити нове замовлення. 
2. У меню виберіть Open Specification (Відкрити специфікацію). 
3. У списку імен, що розкривається, вкажіть ім'я операції - Create (Створити). 
4. Натисніть кнопку ОК. 
5. Повторіть етапи з першого до четвертого для співвіднесення з операціями інших 

повідомлень: 
# Повідомлення 2: Відкрити співвіднесіть з операцією Open () 
# Повідомлення 3: Ввести номер замовлення, замовника і кількість предметів, що замовляються - з 

операцією SubmitInfo(). 
# Повідомлення 4: Зберегти замовлення – з операцією Save (). 
# Повідомлення 5: Зберегти замовлення - з операцією SaveOrder (). 
# Повідомлення 6: Створити порожнє замовлення - з операцією Create (). 
# Повідомлення 7: Ввести номер замовлення, замовника і кількість предметів, що замовляються - з 

операцією SetInfo(). 
# Повідомлення 8: Зберегти замовлення - з операцією SaveOrder (). 
# Повідомлення 9: Інформація про замовлення - з операцією GetInfo (). 
# Повідомлення 10: Зберегти інформацію про замовлення базі даних - з операцією Commit(). 

Співвідношення повідомлень з операціями (якщо ви не створювали описану вище 
діаграму Послідовності) 

1. Клацніть правою кнопкою на повідомленні 1, Створити нове замовлення. 
2. У меню виберіть <new operation> (створити операцію). Відобразиться вікно 

специфікації операції. 
3. У полі імені введіть ім'я операції - Create (Створити). 
4. Натисніть кнопку ОК, щоб закрити вікно специфікації операції та повернутися на 

діаграму. 
5. Ще раз клацніть правою кнопкою миші на повідомленні 1. 
6. У меню виберіть Open Specification (Відкрити специфікацію). 
7. У списку Name (ім'я), що розкривається, вкажіть ім'я нової операції. 
8. Натисніть кнопку ОК. 
9. Повторіть етапи з першого по восьму, щоб створити нові операції та співвіднести з 

ними інші повідомлення: 
# Повідомлення 2: Відкрити співвіднесіть з операцією Open () 
# Повідомлення 3: Ввести номер замовлення, замовника і кількість предметів, що замовляються - з 

операцією SubmitInfo(). 
# Повідомлення 4: Зберегти замовлення – з операцією Save (). 
# Повідомлення 5: Зберегти замовлення - з операцією SaveOrder (). 
# Повідомлення 6: Створити порожнє замовлення - з операцією Create (). 
# Повідомлення 7: Ввести номер замовлення, замовника і кількість предметів, що замовляються - з 

операцією SetInfo(). 
# Повідомлення 8: Зберегти замовлення - з операцією SaveOrder (). 
# Повідомлення 9: Інформація про замовлення - з операцією GetInfo (). 
# Повідомлення 10: Зберегти інформацію про замовлення в базі даних – з операцією Commit. 
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Ваша діаграма має виглядати як на малюнку 6. 

 
Мал. 6. Кооперативна діаграма із показаними на ній операціями. 
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Робота (вправа) 3. Створення діаграм класів 
У цій вправі треба буде згрупувати в пакети класи, створені під час виконання попередньої 

роботи (вправи). Потім вам доведеться створити кілька діаграм класів, на яких ви також 
покажете класи та пакети системи. 

Постановка задачі 
Вивчивши діаграми взаємодії, Боб зрозумів, що система відповідає діловим потребам 

компанії. Після цього Сьюзан прийшла до керівника групи розробників Карен: 
"Ось діаграми Взаємодії, що описують процес введення нового замовлення". 
"Чудово. Приступаємо до розробки". 
Карен подивилася на класи моделі Rose. Вона вирішила об'єднати їх у пакети зі 

стереотипу. Вона створила пакети Entities (Сутності), Boundaries (Кордони) та Control 
(Управління), помістивши в них відповідні класи. Потім для кожного пакета було створено 
діаграми Класів; крім того, на Головній діаграмі були показані пакети та на діаграмі Введення 
нового замовлення - всі класи цього варіанта використання. 

Створення діаграми класів 
Об'єднайте виявлені нами класи у пакети. Створіть діаграму Класів для відображення 

пакетів, діаграми Класів для представлення класів у кожному пакеті та діаграму Класів для 
представлення всіх класів варіанта використання "Ввести нове замовлення". 

Етапи виконання Робота (вправа) 
Налаштування 

1. У меню моделі виберіть Tools > Options (Інструменти > Установки). 
2. Перейдіть на вкладку діаграм. 
3. Переконайтеся, що позначено контрольний перемикач Show Stereotypes (Показати 

стереотипи). 
4. Перевірте, чи позначені контрольні перемикачі Show All Attributes (Показати всі 

атрибути) та Show All Operations (Показати всі операції). 
5. Переконайтеся, що не помічені перемикачі Suppress Attributes (Придушити 

виведення атрибутів) та Suppress Operations (Придушити виведення операцій). 
Створення пакетів 

1. Клацніть правою кнопкою миші на Логічному поданні броузера. 
2. У меню виберіть New > Package (Створити > пакет). 
3. Назвіть новий пакет Entities (Сутності). 
4. Повторіть етапи з першого до третього, створивши пакети Boundaries (межі) та 

Control (управління). 
 

 

Границы

Сущности

Управление
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Мал. 7. Головна діаграма Класів системи обробки замовлень. 
Створення Головної діаграми Класів 

1. Двічі клацніть на Головній діаграмі Класів прямо під Логічним поданням броузера, 
щоб відкрити її. 

2. Перетягніть пакет Entities із броузера на діаграму. 
3. Перетягніть пакети Boundaries та Control із броузера на діаграму. 
4. Головна діаграма Класів має виглядати на малюнку 7. 

Створення діаграми класів для сценарію "Ввести нове замовлення" з усіма класами. 
1. Клацніть правою кнопкою миші на логічному представленні броузера. 
2. У меню виберіть New > Class Diagram (Створити > Діаграму Класів). 
3. Назвіть нову діаграму Класів Add New Order (Введення нового замовлення). 
4. Клацніть у броузері на цій діаграмі двічі, щоб відкрити її. 
5. Перетягніть із броузера всі класи (OrderOptions, OrderDetail, Order, OrderMgr та 

TransactionMgr). 
Діаграма Класів має виглядати на малюнку 8. 

 
Мал. 8. Діаграма класів Add New Order. 

Додавання стереотипів до класів 
1. Клацніть правою кнопкою миші на класі OrderOptions діаграми. 
2. У меню виберіть Open Specification (Відкрити специфікацію). 
3. У полі стереотипу введіть слово Boundary. 
4. Натисніть кнопку ОК. 
5. Клацніть правою кнопкою миші на класі OrderDetail діаграми. 
6. У меню виберіть Open Specification (Відкрити специфікацію). 
7. У списку, що розкривається, у полі стереотипів тепер буде стереотип Boundary. 

Вкажіть його. 
8. Натисніть кнопку ОК. 
9. Повторіть етапи 1 – 4, зв'язавши класи OrderMgr та TransactionMgr зі стереотипом 

Control, а клас Order – зі стереотипом Entity. 
Тепер діаграма Класів має виглядати на малюнку 9. 

ВыборЗаказа

Create()

МенеджерЗаказов

SaveOrder()

ДеталиЗаказа

Open()
SubmitInfo()
Save()

Заказ

Сreate()
SetInfo()
GetInfo()

МенеджерТранзакций

SaveOrder()
Commit()
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Об'єднання класів у пакети 

1. Перетягніть у броузері клас OrderOptions на пакет Boundaries. 
2. Перетягніть клас OrderDetail на пакет Boundaries. 
3. Перетягніть класи OrderMgr та TransactionMgr на пакет Control. 
4. Перетягніть клас Order на пакет Entities. 

Додавання діаграм Класів до кожного пакету 
1. Клацніть правою кнопкою на пакеті Boundaries броузера. 
2. У меню виберіть New > Class Diagram (Створити > Діаграму Класів). 
3. Введіть назву нової діаграми - Main (Головна). 
4. Двічі клацніть на цій діаграмі, щоб відкрити її. 
5. Перетягніть на неї з броузера класи OrderOptions та OrderDetail. 
6. Закрийте діаграму. 
7. Клацніть правою кнопкою на пакеті Entities броузера. 
8. У меню виберіть New > Class Diagram (Створити > Діаграму Класів). 
9. Введіть назву нової діаграми - Main (Головна). 
10. Двічі клацніть на цій діаграмі, щоб відкрити її. 
11. Перетягніть на неї з броузера клас Order. 
12. Закрийте діаграму. 
13. Клацніть правою кнопкою на пакеті Control броузера. 
14. У меню виберіть New > Class Diagram (Створити > 
15. Діаграму класів). 
16. Введіть назву нової діаграми - Main (Головна). 
17. Двічі клацніть на цій діаграмі, щоб відкрити її. 
18. Перетягніть на неї з броузера класи OrderMgr та TransactionMgr. 
19. Закрийте діаграму. 

 

<<Граница>>
ВыборЗаказа

Create()

<<Управление>>
МенеджерЗаказов

SaveOrder()

<<Граница>>
ДеталиЗаказа

Open()
SubmitInfo()
Save()

<<Сущность>>
Заказ

Сreate()
SetInfo()
GetInfo()

<<Управление>>
МенеджерТранзакций

SaveOrder()
Commit()
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Мал. 9. Стереотипи класів для варіанта використання Ввести нове замовлення. 
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Робота (вправа) 4. Створення діаграм класів (облік нових вимог) 
У вправі 2 було створено кілька операцій для класів нашого завдання. У попередній вправі 

ми завдали класи на діаграму. У цій вправі до описів операцій будуть додані деталі, включаючи 
параметри та типи значень, що повертаються. Крім того, у класів буде визначено атрибути. 

Постановка задачі 
Після того, як Карен розробила діаграму Класів для варіанта використання "Ввести нове 

замовлення", вона почала заповнювати її подробицями. Як мову програмування був обраний 
С++, що дозволило додати до класів параметри операцій, типи даних і типи значень, що 
повертаються. 

Для визначення атрибутів Карен знову звернулася до потоку подій. В результаті до класу 
Order діаграми Класів були додані атрибути Order Number (номер замовлення) та Customer 
Name (Ім'я клієнта). Вона переглянула також список товарів, що замовляються. Так як в одному 
замовленні можна вказати велику кількість товарів, і кожен з них має свої власні дані та 
поведінку, Карен вирішила моделювати їх як самостійні класи, а не як атрибути класу Order. 

Щоб привести модель у відповідність до нових ідей, довелося оновити діаграму 
Послідовностей, як показано на малюнку 10. 

 
Мал. 10. Оновлена діаграма Послідовностей. 
 

У цей момент Боб вирішив змінити вимоги: 
"Нам треба відстежувати дату замовлення та дату його виконання. Крім того, оскільки у нас 

з'явилися нові постачальники, трохи змінилася процедура інвентаризації." 
Спочатку Карен документувала нові вимоги щодо дат та розглянула зміни у процедурі 

інвентаризації "на високому рівні". Оскільки в даний момент вона працювала над варіантом 
використання "Ввести нове замовлення", її найбільше цікавило, як ці процедурні зміни 
вплинуть на цей варіант використання. Робота з варіантом використання "Провести 

Форма выбора
варианта заказа:

ВыборЗаказа

Форма Детали
заказа:

ДеталиЗаказа
Заказ №1234:

Заказ

1: Create()

3: SubmitInfo()

Продавец

Менеджер
заказов:

МенеджерЗаказов

2: Open()

6: Create()

Менеджер
транзакций:
Менеджер
транзакций

4: Save()

7: SetInfo()

10: SaveOrder()

5: SaveOrder()

11: GetInfo()

13: Commit()

Компект
мебели:

ПозицияЗаказа

8: Create()

9: SetInfo()

12: GetInfo()
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інвентаризацію" була запланована на наступний місяць, тоді вона подбає про деталі 
відповідних процедур. Виявилося, що хоча вони надзвичайно сильно вплинуть на варіант 
використання "Провести інвентаризацію", але зовсім не позначаться на варіанті використання 
"Ввести нове замовлення". 

Нові вимоги, пов'язані з датами, призвели до необхідності введення кількох нових 
атрибутів у клас Order. Після цього модель знову почала відповідати останнім пред'явленим до 
системи вимогам. 

Додавання атрибутів та операцій 
Додамо атрибути та операції до класів діаграми Класів "Ввести нове замовлення". Для 

атрибутів та операцій використовуємо специфічні для мови особливості. Встановимо 
параметри так, щоб показувати всі атрибути, всі операції та їх сигнатури. Видимість покажемо 
за допомогою нотації UML. 

Етапи виконання Робота (вправа) 
Налаштування 

1. У меню моделі виберіть Tools > Options. 
2. Перейдіть на вкладку Diagram. 
3. Переконайтеся, що перемикач Show Visibility позначений. 
4. Переконайтеся, що перемикач Show Stereotypes позначений. 
5. Переконайтеся, що перемикач Show Operation Signatures позначений. 
6. Переконайтеся, що перемикачі Show All Attributes та Show All Operations позначені. 
7. Переконайтеся, що перемикачі Suppress Attributes та Suppress Operations не 

позначені. 
8. Перейдіть на вкладку Notation. 
9. Переконайтеся, що перемикач Visibility as Icons не помічений. 

Додавання нового класу 
1. Знайдіть у броузері діаграму Класів варіанта використання "Ввести нове 

замовлення". 
2. Клацніть на ній двічі, щоб відкрити її. 
3. Натисніть кнопку Class панелі інструментів. 
4. Натисніть мишею всередині діаграми, щоб помістити там новий клас. 
5. Назвіть OrderItem (Позиція Замовлення). 
6. Призначте цьому класу стереотип Entity. 
7. У броузері перетягніть клас у пакет Entities. 

Додавання атрибутів 
1. Клацніть правою кнопкою миші на класі Order (Замовлення). 
2. У меню виберіть New Attribute (Створити атрибут). 
3. Введіть новий атрибут OrderNumber : Integer (НомерЗамовлення) 
4. Натисніть клавішу Enter. 
5. Введіть наступний атрибут CustomerName : String (Найменування Замовника). 
6. Повторіть етапи 4 і 5, додавши атрибути OrderDate : Date (Дата Замовлення) та 

OrderFillDate : Date (Дата Заповнення Замовлення). 
7. Клацніть правою кнопкою миші на класі OrderItem. 
8. У меню виберіть New Attribute (Створити атрибут). 
9. Введіть новий атрибут ItemID: Integer (ІдентифікаторПредмета). 
10. Натисніть клавішу Enter. 
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11. Введіть наступний атрибут ItemDescription : String (ОписПредмета). 
Додавання операцій до класу OrderItem 

1. Клацніть правою кнопкою миші на класі OrderItem. 
2. У меню виберіть New Operation (Створити операцію). 
3. Введіть нову операцію Create. 
4. Натисніть клавішу Enter. 
5. Введіть наступну операцію SetInfo 
6. Натисніть клавішу Enter. 
7. Введіть наступну операцію GetInfo. 

Детальний опис операцій за допомогою діаграми Класів 
1. Клацніть мишею на класі Order, виділивши його в такий спосіб. 
2. Клацніть на цьому класі ще раз, щоб перемістити курсор всередину. 
3. Відредагуйте операцію Create(), щоб вона виглядала так: Create() : Boolean 
4. Відредагуйте операцію SetInfo(), щоб вона виглядала так: SetInfo(OrderNum: Integer, 

Customer: String, OrderDate: Date, FillDate: Date): 
5. Відредагуйте операцію GetInfo(), щоб вона виглядала так: GetInfo() : String 

Детальний опис операцій за допомогою броузера 
1. Знайдіть у броузері клас OrderItem. 
2. Щоб відкрити цей клас, клацніть на значку "+" поруч із ним. У броузері з'являться 

його атрибути та операції. 
3. Двічі клацніть на операції GetIInfo(), щоб відкрити вікно специфікації. 
4. У списку Return class (повертається клас) вкажіть String. 
5. Натисніть кнопку ОК, закривши вікно специфікації операції. 
6. Двічі клацніть у броузері на операції SetInfo класу OrderItem, щоб відкрити вікно її 

специфікації. 
7. У списку Return class, що розкривається, вкажіть Boolean. 
8. Перейдіть на вкладку Подробиці. 
9. Клацніть правою кнопкою миші на білому полі в області аргументів, щоб додати 

новий параметр. 
10. У меню виберіть пункт Insert. Rose додасть туди аргумент під назвою argname. 
11. Клацніть один раз на цьому слові, щоб виділити його, та змініть ім'я аргументу на ID. 
12. Клацніть на колонці Type, відкривши список типів, що розкривається. У ньому 

виберіть тип Integer. 
13. Клацніть на колонці Default, щоб додати значення аргументу за промовчанням. 

Введіть число 0. 
14. Натисніть кнопку ОК, закривши вікно специфікації операції. 
15. Двічі клацніть на операції Create() класу OrderItem, щоб відкрити вікно її специфікації. 
16. У списку Return class, що розкривається, вкажіть Boolean. 
17. Натисніть кнопку ОК, закривши вікно специфікації операції. 

Детальний опис операцій за допомогою будь-якого з описаних методів 
1. Використовуючи броузер або діаграму класів, введіть наступну сигнатуру операцій 

класу OrderDetail: 
Open() : Boolean 
SubmitInfo() : Boolean 
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Save() : Boolean 

2. Використовуючи броузер або діаграму класів, введіть наступну сигнатуру операцій 
класу OrderOptions: 

Create() : Boolean 

3. Використовуючи броузер або діаграму класів, введіть наступну сигнатуру операцій 
класу OrderMgr: 

SaveOrder(OrderID : Integer) : Boolean 

4. Використовуючи броузер або діаграму класів, введіть наступну сигнатуру операцій 
класу TransactionMgr: 

SaveOrder(OrderID : Integer) : Boolean 
Commit() : Integer 
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Робота (вправа) 5. Створення діаграм класів (додавання зв'язків між 
класами) 

У цій вправі будуть визначені зв'язки між класами, що беруть участь у варіанті 
використання "Ввести нове замовлення". 

Постановка задачі 
Після додавання до класів атрибутів та операцій Карен була майже готова до генерації 

коду. Спочатку, однак, вона мала вивчити зв'язки між класами. 
Щоб знайти зв'язки, Карен вивчила діаграми послідовності. Усі взаємодіючі там класи 

потребували визначення відповідних зв'язків на діаграмах Класів. Після виявлення зв'язків 
Карен додала їх у модель. 

 

Додавання зв'язків 
Додамо зв'язки до класів, що беруть участь у варіанті використання "Ввести нове 

замовлення". 
Етапи виконання Робота (вправа) 

Налаштування 
1. Знайдіть у броузері діаграму Класів "Введення нового замовлення" 
2. Двічі клацніть на ній, щоб відкрити її. 
3. Перевірте, чи на панелі інструментів діаграми є кнопка Unidirectional Association. 

Якщо її немає, продовжуйте налаштування, виконавши етапи 4 і 5. Якщо є, 
приступайте до виконання самої роботи (вправи). 

4. Клацніть правою кнопкою миші на панелі інструментів діаграми і виберіть пункт 
Customize у меню. 

5. Додайте на панель кнопку Create A Unidirectional Association. 
Додавання асоціацій 

1. Натисніть кнопку панелі інструментів Unidirectional Association. 
2. Намалюйте асоціацію від класу Вибір Замовлення (OrderOptions) до класу Деталі 

Замовлення (OrderDetail). 
3. Повторіть етапи 1 та 2, створивши ще асоціації: 

# Від класу OrderDetail до класу МенеджерЗамовлень (OrderMgr) 
# Від класу OrderMgr до класу Замовлення (Order) 
# Від класу OrderMgr до класу МенеджерТранзакцій (TransactionMgr) 
# Від класу TransactionMgr до класу Order 
# Від класу TransactionMgr до класу Позиція Замовлення (OrderItem) 
# Від класу Order до класу OrderItem 

4. Клацніть правою кнопкою миші на односпрямованій асоціації між класами 
OrderOptions та OrderDetail, з боку класу OrderOptions. 

5. У меню виберіть пункт Multiplicity > Zero or One. 
6. Клацніть правою кнопкою миші на іншому кінці односпрямованої асоціації. 
7. У меню виберіть пункт Multiplicity > Zero or One. 
8. Повторіть етапи 4 - 7, додавши на діаграму значення множинності інших асоціацій, як 

показано малюнку 11. 
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Мал. 11. Асоціації сценарію "Запровадити нове замовлення". 
  

<<Граница>>
ВыборЗаказа

Create()

<<Управление>>
МенеджерЗаказов

SaveOrder()

<<Граница>>
ДеталиЗаказа

Open()
SubmitInfo()
Save()

<<Сущность>>
Заказ

OrderNumber: Integer
CustomerName: String
OrderDate: Date
OrderFillDate: Date

Сreate(): Boolean
SetInfo(): Boolean
GetInfo(): String

<<Управление>>
МенеджерТранзакций

SaveOrder()
Commit()

<<Сущность>>
ПозицияЗаказа

ItemId: Integer
ItemDescription: String

Сreate()
SetInfo()
GetInfo()

0..1

0..1

0..1

0..1

0..1

0..1

0..*

1

0..*

0..1

1

1..* 0..*

0..1
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Робота (вправа) 6. Створення діаграми станів 
У цій вправі буде створено діаграму станів для класу Order. 

Постановка задачі 
Проектуючи клас Order, Карен зрозуміла, що за поведінкою цього класу треба спостерігати. 

Багато вимог до класу значно змінювалися за зміни стану його екземпляра. Наприклад, 
замовлення, виконання яких було припинено, вели себе не так, як виконані замовлення, а ті, у 
свою чергу, не так, як скасовані замовлення. 

Щоб переконатися, що проект задовольняє всі ці вимоги, Карен зі своєю групою 
розробників створила діаграму Стан для класу Order. За допомогою цієї діаграми розробники 
спромоглися остаточно зрозуміти, як треба писати код для цього класу. 

Створення діаграми Стан 
Розробте діаграму станів для класу Order, показану на малюнку 12. 

 
Мал. 12. Діаграма станів для класу Order. 

Етапи виконання Робота (вправа) 
Створення діаграми 

1. Знайдіть у броузері клас Order. 
2. Клацніть на класі правою кнопкою миші і в меню вкажіть пункт Open State Diagram. 

Додавання початкового та кінцевого станів 
1. На панелі інструментів натисніть кнопку Start State (Початковий стан). 

Инициализация
entry: Сохранить дату заказа
do: Собрать клиентскую информацию
do: Добавить к заказу новые позиции

Выполнение заказа
отложено

Отменен

exit: Сохранить дату отмены

H

Отменить заказ

Выполнить заказ

Добавить к заказу новую позицию
 [Не осталось незаполненных позиций]

H

Выполнен

do: Выписать счет

Добавить к заказу новую позицию [остаются незаполненные позиции]
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2. Покладіть цей стан на діаграму. 
3. На панелі інструментів натисніть кнопку End State (Кінцевий стан). 
4. Покладіть цей стан на діаграму. 

Додавання суперстану 
1. На панелі інструментів натисніть кнопку State (Стан). 
2. Покладіть цей стан на діаграму. 

Додавання станів, що залишилися 
1. На панелі інструментів натисніть кнопку State (Стан). 
2. Покладіть цей стан на діаграму. 
3. Назвіть стан Cancelled (Скасовано). 
4. На панелі інструментів натисніть кнопку State (Стан). 
5. Покладіть цей стан на діаграму. 
6. Назвіть стан Filled. 
7. На панелі інструментів натисніть кнопку State (Стан). 
8. Покладіть цей стан на діаграму всередину суперстану. 
9. Назвіть стан Initialization (Ініціалізація). 
10. На панелі інструментів натисніть кнопку State (Стан). 
11. Покладіть цей стан на діаграму всередину суперстану. 
12. Назвіть стан Pending (Виконання замовлення призупинено). 

Детальний опис станів 
1. Двічі клацніть на стані Initialization (Ініціалізація). 
2. Клацніть правою кнопкою миші у вікні Actions (Дії). 
3. У меню виберіть Insert (Вставити). 
4. Двічі клацніть на новій дії. 
5. Назвіть Store Order Date (Зберегти дату замовлення). 
6. Переконайтеся, що у вікні When (Коли) вказано пункт On Entry (На вході). 
7. Повторіть етапи 3 - 7, додавши такі дії: 

# Collect Customer Info (Зібрати клієнтську інформацію), у вікні When вказати пункт Do 
# Add Order Items (Додати до замовлення нові графи), у вікні When вказати Do 

8. Натисніть кнопку ОК двічі, щоб закрити специфікацію. 
9. Двічі клацніть Cancelled (Скасовано). 
10. Повторіть етапи 2 - 7, додавши дію Store Cancellation Data (Зберегти дату 

скасування), вказати пункт On Exit (на виході) 
11. Натисніть кнопку ОК двічі, щоб закрити специфікацію. 
12. Двічі клацніть на стані Filled (Виконаний). 
13. Повторіть етапи 2 - 7, додавши дію Bill Customer (Виписати рахунок), вказати пункт 

Do. 
14. Натисніть кнопку ОК двічі, щоб закрити специфікацію. 

Додавання переходів 
1. Натисніть кнопку Transition (Перехід) на панелі інструментів. 
2. Клацніть на початковому стані. 
3. Проведіть лінію переходу до стану Initialization (Ініціалізація). 
4. Повторіть етапи з першого до третього, створивши наступні переходи: 
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# Від стану Initialization (Ініціалізація) до стану Pending (Виконання замовлення призупинено) 
# Від стану Pending (Виконання замовлення призупинено) до стану Filled (Виконаний) 
# Від суперстану до стану Cancelled (Скасовано) 
# Від стану Cancelled (Скасовано) до кінцевого стану 
# Від стану Filled (Виконаний) до кінцевого стану 

5. На панелі інструментів натисніть кнопку Transition to Self (Перехід до себе). 
6. Клацніть на стані Pending (Виконання замовлення припинено). 

Детальний опис переходів 
1. Двічі клацніть на переході від стану Initialization (Ініціалізація) до стану Pending 

(Виконання замовлення припинено), відкривши вікно специфікації. 
2. У полі Event (Подія) введіть фразу Finalize order (Виконати замовлення). 
3. Натисніть кнопку ОК, закривши вікно специфікації. 
4. Повторіть етапи з першого до третього, додавши подію Cancel Order (Скасувати 

замовлення) до переходу між суперстаном та станом Cancelled (Скасовано). 
5. Двічі клацніть на переході від стану Pending (Виконання замовлення призупинено) до 

стану Filled (Виконаний), відкривши вікно специфікації. 
6. У полі Event (Подія) введіть фразу Add Order Item (Додати до замовлення нову 

позицію). 
7. Перейдіть на вкладку Подробиці. 
8. У полі Condition (Умова) введіть No unfilled items remaining (Не залишилося 

незаповнених позицій). 
9. Натисніть кнопку ОК, закривши вікно специфікації. 
10. Двічі клацніть на рефлексивному переході (Transition to Self) стану Pending 

(Виконання замовлення призупинено). 
11. У полі Event (Подія) введіть фразу Add Order Item (Додати до замовлення нову 

позицію). 
12. Перейдіть на вкладку Подробиці. 
13. У полі Condition (Умова) введіть Unfilled items remaining (Залишаються незаповнені 

позиції). 
14. Натисніть кнопку ОК, закривши вікно специфікації. 
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Робота (вправа) 7. Створення діаграми компонентів 
У цій вправі буде створено діаграму Компонентів системи обробки замовлень. На даний 

момент вже визначено всі класи, які потрібні для варіанта використання "Ввести нове 
замовлення". У міру реалізації інших варіантів використання діаграму слід додавати нові 
компоненти. 

Постановка задачі 
Завершивши аналіз та проектування системи, один із розробників проекту Ден розробив 

діаграми Компонентів. Вибравши як мову програмування С++, для кожного класу Ден створив 
відповідні мови компоненти. 

На малюнку 13 показано головну діаграму Компонентів всієї системи. Увага на ній 
приділяється пакетам компонентів, що створюються. 

 
Мал. 13. Головна діаграма компонентів системи. 
На малюнку 14 показано всі компоненти пакету Entities. Ці компоненти містять класи пакету 

Entities Логічного представлення системи. 
 

 
Мал. 14. Діаграма компонентів пакету Entities. 
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На малюнку 15 показано компоненти пакета Control. Вони містять класи пакета Control 
Логічного представлення системи. 

 

 
Мал. 15. Діаграма компонентів пакета Control. 
Нарешті, малюнку 16 показані компоненти пакета Boundaries. Вони також відповідають 

класам однойменного пакета Логічного представлення системи. 

 
 

Мал. 16. Діаграма компонентів пакета Boundaries. 
На малюнку 17 показані усі компоненти системи. Ми назвали цю діаграму діаграмою 

Компонентів системи. На ній ви можете бачити всі залежності між усіма компонентами 
проектованої системи. 
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Мал. 17. Діаграма компонентів системи. 

Етапи виконання Робота (вправа) 
Створення пакетів компонентів 

1. Клацніть правою кнопкою миші на представленні компонентів у броузері. 
2. У меню виберіть New > Package (Створити > пакет). 
3. Назвіть цей пакет Entities (Сутності). 
4. Повторіть етапи з першого до третього, створивши пакети Boundaries (Межі) та 

Control (Керування). 
Додавання пакетів на Головну діаграму Компонентів 

1. Відкрийте Головну діаграму Компонентів двічі клацнувши на ній. 
2. Перетягніть пакети Entities, Boundary та Control із броузера на Головну діаграму. 

Малювання залежностей між пакетами 
1. На панелі інструментів натисніть кнопку Dependency (Залежність). 
2. Клацніть на упаковці Boundaries Головної діаграми Компонентів. 
3. Проведіть лінію залежності до пакування Control. 
4. Повторіть етапи 1 - 3, ще провівши залежність від пакета Control до пакета Entities. 

Додавання компонентів до пакетів та малювання залежностей 
1. Двічі клацніть мишею на пакеті Entities Головної діаграми Компонентів, відкривши 

Головну діаграму Компонентів цього пакета. 
2. Натисніть кнопку Package Specification (Специфікація пакета) на панелі інструментів. 
3. Покладіть специфікацію пакета на діаграму. 
4. Введіть назву специфікації пакета OrderItem. 
5. Повторіть етапи 2 – 4, додавши специфікацію пакета Order. 
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6. На панелі інструментів натисніть кнопку Package Body (Тіло пакета). 
7. Покладіть його на діаграму. 
8. Введіть ім'я тіла OrderItem. 
9. Повторіть етапи 6 – 8, додавши тіло пакету Order. 
10. На панелі інструментів натисніть кнопку Dependency (Залежність). 
11. Клацніть на тілі пакету OrderItem. 
12. Проведіть лінію залежності від нього до специфікації пакета OrderItem. 
13. Повторіть етапи 10 - 12, додавши лінію залежності між тілом пакета Order та 

специфікацією пакета Order. 
14. Повторіть етапи 10-12, додавши лінію залежності від специфікації пакета Order до 

специфікації пакета OrderItem. 
15. За допомогою описаного методу створіть такі компоненти та залежності: 

Для пакету Boundaries: 
# Специфікацію пакету OrderOptions 
# Тіло пакету OrderOptions 
# Специфікацію пакету OrderDetail 
# Тіло пакету OrderDetail 

Залежність у пакеті Boundaries: 
# Від тіла пакету OrderOptions до специфікації пакета OrderOptions 
# Від тіла пакету OrderDetail до специфікації пакета OrderDetail 
# Від специфікації пакету OrderOptions до специфікації пакета OrderDetail 

 
Для пакета Control: 
# Специфікацію пакету OrderMgr 
# Тіло пакету OrderMgr 
# Специфікацію пакету TransactionMgr 
# Тіло пакету TransactionMgr 

Залежно в пакеті Control: 
# Від тіла пакету OrderMgr до специфікації пакета OrderMgr 
# Від тіла пакету TransactionMgr до специфікації пакету TransactionMgr 
# Від специфікації пакету OrderMgr до специфікації пакету TransactionMgr 

Створення діаграми Компонентів системи 
1. Клацніть правою кнопкою миші на представленні Компонентів у броузері. 
2. У меню виберіть New > Component Diagram 
3. Назвіть нову діаграму System. 
4. Двічі клацніть на цій діаграмі. 

Розміщення компонентів на діаграмі Компонентів системи 
1. Якщо це ще не було зроблено, розгорніть у броузері пакет компонентів Entities, щоб 

відкрити його. 
2. Клацніть на специфікації пакета Order у пакеті компонентів Entities. 
3. Перетягніть цю специфікацію на діаграму. 
4. Повторіть етапи 2 та 3, помістивши на діаграму специфікацію пакету OrderItem. 
5. За допомогою цього методу помістіть на діаграму такі компоненти: 

З пакету компонентів Boundaries: 
# Специфікацію пакету OrderOptions 
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# Специфікацію пакету OrderDetail 

З пакету компонентів Control: 
# Специфікацію пакету OrderMgr 
# Специфікацію пакету TransactionMgr 

6. На панелі інструментів натисніть кнопку Task Specification (Специфікація завдання). 
7. Помістіть специфікацію задачі на діаграму та назвіть її OrderClientExe. 
8. Повторіть етапи 6 та 7 для специфікації задачі OrderServerExe. 

Додавання залежностей, що залишилися, на діаграму Компонентів системи 
Вже існуючі залежності будуть автоматично показані на діаграмі компонентів системи після 
додавання туди відповідних компонентів. Тепер треба додати інші залежності. 

1. На панелі інструментів натисніть кнопку Dependency (Залежність). 
2. Натисніть специфікацію пакета OrderDetail. 
3. Проведіть лінію залежності до специфікації пакета OrderMgr. 
4. Повторіть етапи 1 - 3, створивши такі залежності: 

# Від специфікації пакета OrderMgr до специфікації пакета Order 
# Від специфікації пакету TransactionMgr до специфікації пакету OrderItem 
# Від специфікації пакету TransactionMgr до специфікації пакета Order 
# Від специфікації завдання OrderClientExe до специфікації пакета OrderOptions 
# Від специфікації завдання OrderServerExe до специфікації пакета OrderMgr 

Співвіднесення класів із компонентами 
1. У Логічному поданні броузера знайдіть клас Order пакету Entities. 
2. Перетягніть цей клас на специфікацію пакета компонента Order у поданні 

Компонентів броузера. В результаті клас Order буде співвіднесений зі специфікацією 
пакета компонента Order. 

3. Перетягніть клас Order на тіло пакету компонента Order у поданні Компонентів 
броузера. В результаті клас Order буде співвіднесений із тілом пакету компонента 
Order. 

4. Повторіть етапи 1 - 3, співвіднісши з класами такі компоненти: 
# Клас OrderItem зі специфікацією пакету OrderItem 
# Клас OrderItem з тілом пакету OrderItem 
# Клас OrderOptions із специфікацією пакету OrderOptions 
# Клас OrderOptions з тілом пакету OrderOptions 
# Клас OrderDetail зі специфікацією пакету OrderDetail 
# Клас OrderDetail з тілом пакету OrderDetail 
# Клас OrderMgr зі специфікацією пакету OrderMgr 
# Клас OrderMgr з тілом пакету OrderMgr 
# Клас TransactionMgr зі специфікацією пакету TransactionMgr 
# Клас TransactionMgr із тілом пакету TransactionMgr 
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Робота (вправа) 8. Створення діаграми розміщення 
У цій вправі буде створено діаграму Розміщення системи обробки замовлень. 

Постановка задачі 
Команда розробників завершила весь попередній аналіз і проектування системи. Варіанти 

використання, взаємодії між об'єктами та компонентами чітко описані. Тим не менш, підрозділу 
адміністрування мережі необхідно знати, на яких комп'ютерах будуть розміщуватись різні 
компоненти системи. У зв'язку з цим довелося розробити діаграму Розміщення для системи 
обробки замовлень. 

Створення діаграми Розміщення 
Розробте діаграму Розміщення системи обробки замовлень. Готова діаграма має 

виглядати на малюнку 18. 
Етапи виконання Робота (вправа) 

Додавання вузлів до діаграми Розміщення 
1. Двічі клацніть мишею на представленні Розміщення у броузері, щоб відкрити 

діаграму Розміщення. 
2. Натисніть кнопку Processor (Процесор) на панелі інструментів. 
3. Клацніть на діаграмі, помістивши процесор. 
4. Введіть назву процесора "Сервер бази даних". 
5. Повторіть етапи 2 - 4, додавши такі процесори: 

# Сервер програми 
# Клієнтська робоча станція №1 
# Клієнтська робоча станція №2 

6. На панелі інструментів натисніть кнопку Device (Пристрій). 
7. Клацніть на діаграмі, помістивши на неї пристрій. 
8. Назвіть його "Принтер". 

Додавання зв'язків 
1. Натисніть кнопку Connection (Зв'язок) на панелі інструментів. 
2. Виберіть процесор "Сервер бази даних". 
3. Проведіть лінію зв'язку до процесора "Сервер програми". 
4. Повторіть етапи 1 - 3, додавши такі зв'язки: 

# Від процесора "Сервер програми" до процесора "Клієнтська робоча станція №1" 
# Від процесора "Сервер програми" до процесора "Клієнтська робоча станція №2" 
# Від процесора "Сервер програми" до пристрою "Принтер" 

 
 



35 
 

 
 

Мал. 18. Діаграма Розміщення системи обробки замовлень. 
Додавання процесів 

1. Клацніть правою кнопкою миші на процесорі "Сервер програми" в броузері. 
2. У меню виберіть New > Process (Створити > Процес). 
3. Введіть ім'я процесу OrderServerExe. 
4. Повторіть етапи 1 – 3, додавши ще процеси: 

# На процесорі "Клієнтська робоча станція №1" - процес OrderClientExe 
# На процесорі "Клієнтська робоча станція №2" - процес ATMClientEXE 

Показ процесів на діаграмі 
1. Клацніть правою кнопкою миші на процесорі "Сервер програми". 
2. У меню виберіть пункт Show Processes (Показати процеси). 
3. Повторіть етапи 1 та 2, показавши процеси на наступних процесорах: 

# Клієнтська робоча станція №1 
# Клієнтська робоча станція №2. 

  

Сервер базы
данных

Сервер
приложений Принтер

Рабочая
станция 2

Рабочая
станция 1

OrderServerExe

OrderClientExe ATMClientExe
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Робота (вправа) 9. Генерація коду C++ 
У попередніх роботах (вправах) була створена модель для системи обробки замовлень 

(Order Entry). Тепер згенеруємо програмний код C++ цієї системи. При цьому скористаємося 
діаграмою Компонентів системи, представленою на малюнку 19. Для генерації програмного 
коду необхідно виконати наведені нижче кроки. 

Етапи виконання Робота (вправа) 
Введення тіл пакетів на діаграму Компонентів системи 

1. Відкрийте діаграму компонентів системи. 
2. Виберіть у броузері Entities: тіло пакету Order. 
3. "Перетягніть" тіло пакету Order на діаграму Компонентів системи. 
4. Повторіть пп. 2 та 3 для наступних компонентів: 

Entities: тіло пакету OrderItem. 
Boundaries: тіло пакету OrderOptions. 
Boundaries: тіло пакету OrderDetail. 
Control: тіло пакету TransactionMgr. 
Control: тіло пакету OrderMgr. 
 

 
 

Мал. 19. Діаграма компонентів системи Order Entry 
Встановлення мови C++ 

1. Відкрийте специфікацію компонента Order (специфікацію пакета) у пакеті 
компонентів Entities. 

2. Виберіть мову C++. 
3. Повторіть пп. 1 та 2 для наступних компонентів: 
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Entities: тіло пакету Order. 
Entities: специфікація пакету OrderItem. 
Entities: тіло пакету OrderItem. 
Boundaries: специфікація пакету OrderOptions. 
Boundaries: тіло пакету OrderOptions. 
Boundaries: специфікація пакету OrderDetail. 
Boundaries: тіло пакету OrderDetail. 
Control: специфікація пакету TransactionMgr. 
Control: тіло пакету TransactionMgr. 
Control: специфікація пакета OrderMgr. 
Control: тіло пакету OrderMgr. 
Специфікація задачі OrderClientExe. 
Специфікація задачі OrderServerExe. 

Генерація програмного коду C++ 
Відкрийте діаграму компонентів системи. 
Виберіть усі об'єкти на діаграмі Компонентів системи. 
Виберіть Tools > C++ > Code Generation у меню. 
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Робота (вправа) 10. Генерація Java-коду 
Раніше було створено модель для системи обробки замовлень (Order Entry). Тепер 

згенеруємо програмний код Java для цієї системи. У цьому скористаємося діаграмою 
компонентів системи, представленої малюнку 20. 

 
Мал. 20. Діаграма компонентів системи Order Entry 
Для генерації програмного коду необхідно виконати наведені нижче кроки. 

Етапи виконання Робота (вправа) 
Видалення тіл пакетів 

1. У вправі 7 були створені специфікації та пакети тіла для всіх класів. Оскільки тіла 
пакетів Java не використовуються, першим кроком є видалення їх з моделі. 

2. Відкрийте специфікацію компонентів системи. 
3. Виберіть тіло OrderOptions. 
4. Натисніть Ctrl+D, вилучивши тіло пакета. 
5. Повторіть пп. 3 та 4 для наступних компонентів: 

Тіло пакету OrderDetail. 
Тіло пакету OrderMgr. 
Тіло пакету Order. 
Тіло пакету OrderItem. 
Тіло пакету TransactionMgr. 

Встановлення мови Java 
Установка мови проводиться також як описано у вправі 9. Відмінність полягає лише в тому, 

що замість С++ встановлюється Java. 
Імпорт типів даних Java 

1. Для генерації програмного коду Java у використовуваний файл моделі необхідно 
включити типи даних Java. Ці типи містяться в каталозі Data Types на компакт-диску. 
Відкрийте основну діаграму класів. 
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2. Виберіть File > Import у меню. Імпортуйте файл Data Types\Java Classes.ptl із 
компакт-диска. 

3. Відкрийте головну діаграму компонентів. 
4. Виберіть File > Import у меню. Імпортуйте файл Data Types\Java Components.ptl із 

компакт-диска. 
Встановлення типів даних Java 

1. Через те, що типи даних у Java іменуються трохи інакше, ніж у C++, тепер потрібно 
встановити типи даних всім атрибутів і операцій те щоб вони стали достовірними типами. 
ПРИМІТКА: якщо всі раніше запропоновані роботи (вправи) виконані, потрібно лише змінити 
тип даних Date на java.util.Date. 

2. Відкрийте діаграму Add Order Class. 
3. Встановіть типи даних для атрибутів, операцій та аргументів, як показано на малюнку 21. 
 

Мал. 21. Типи даних Java для класів Order Entry 
Генерація програмного коду Java 

1. Відкрийте діаграму компонентів системи. 
2. Виберіть усі об'єкти на діаграмі. 
3. Виберіть Tools > Java > Generate Java у меню 
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Усі вправи взяті з джерела: Уенді Боггс (Wendy Boggs) та Майкл Боггс (Michael Boggs) UML та Rational Rose 
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